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Introduction to Indoor Forecaster

The Forecaster application suite is used to generate coverage analysis maps of survey areas.
These survey areas will be located indoors or any other area where there is insufficient GPS
coverage.

Forecaster consists of three separate applications. Indoor Projector imports an image
(BMP, JPEG) of the survey area and creates a linear projection onto this area.

Forecaster Collector collects RF data within the survey area and correlates it to the
projection file created with Projector. This data is collected with the BVS Coyote Receiver
hardware.

This data is then input into Forecaster Analyzer, where it is then analyzed and processed

into various types of reports. These reports represent the RF coverage validation and
prediction over the survey area.

Quick Start

You will need the following to get started with your survey.

1. An image file of the area to be surveyed.
2. Coyote hardware.
3. Technical information on transmitters in the survey area (if possible).

You will perform the following steps in order to complete your survey. These steps are
outlined in the sections below corresponding to the various applications.

Import your image file into Indoor Projector

Create a projection based on known distances in the survey area.

Save the newly created projection file.

Copy projection file on the device where the Forecaster Collector will be
running.

Import the projection file into Forecaster Collector.

Collect data points over the survey area.

Save data file.

Copy data and projection file onto device where Forecaster Analyzer will be run.
Import data and projection file into Forecaster Analyzer.

Create reports on coverage.

Save and print out reports for presentation on the coverage analysis.
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I. Indoor Projector

Introduction

The BVS Indoor Projector imports an image of an area to be surveyed and outputs a base file
with information to project data onto to the image.

Projector is a Windows application that can run on any PC or tablet with a minimum of
Windows XP installed. The output file is used by a “Collector” program to collect and
overlay RF data points onto the survey projection.

The resulting combination of collected data and the projection is used in an “Analysis”
program to show RF coverage information in the surveyed area.
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Figure 1 — Indoor Projector

Projector also allows you to add 2.4 and 5 GHz objects such as access points and
interferers. Text can also be added to the floor plan.



INSTALLATION

To install the application from a CD, place the CD in the drive. Choose the Indoor
Projector button. Follow the installation instructions on the screen from this point.

If you are installing from a Tablet, use the SD card provided with the USB Flash card
driver. Insert the USB driver into a USB slot. The device will show up as new drive letter
(i.e. D:). Run the setup or autorun program from the root of the drive. Then choose the
Indoor Projector button and follow the installation instructions.

QUICK START

Creating a projection file that is ready for use with the Collector requires the following
steps. See the sections below for individual explanations. Projector can import any of the
following file formats: Monochrome BMP, 16-bit color BMP, 256 color BMP, 24-bit BMP,
GIF, ICO, TIF, JPG and PNG.

CREATE A PROJECTION

SET THE DIMENSIONS FOR THE ASPECT RATIO
ADJUST SIZE OF FLOOR PLAN IF NECESSARY

ADD STATIC OBJECTS TO FLOOR PLAN IF NECESSARY
ADD CUSTOM IMAGES AS STATIC OBJECTS

ADD WALLS, WINDOWS, AND DOORS

SAVE FILE

AR el A

CREATE A PROJECTION

Use FILE/NEW on the menu to create a new projection file. Choose a floor plan from the
popup window to use as a base for your site. You may use a .bmp, .jpg, .gif etc.

SET THE DIMENSIONS FOR THE ASPECT RATIO

Click the ruler icon in the toolbox. Look for a location on the projection that you know the
distance. Click on the first point of the measurement. A flag will mark the spot. Click on the
second point of the measurement.

Now enter the distance and units for the measurement. Repeat steps 2 thru 4 for a second
measurement. Make sure that the second measurement is in a different orientation from the
first point. Keep repeating until you receive a message saying that a valid projection exists.
Points used for the projection may be deleted from the listbox on the left status bar.

ADJUST THE SIZE OF THE FLOOR PLAN

There are two types of image reduction available in Projector. There are multiple
algorithms used to achieve the reduction.



Scaling

Scaling the image reduces the size of the image while attempting to keep all of the
features of the floor plan. In effect, the image is shrunk. Scaling the image can be
done in different ways. Different interpolation modes for scaling the image are listed
below. These modes use different techniques to determine how to reduce groups of
pixels into one which is representative of the group.

Interpolation Modes

D is the destination image and S is the source image. Here are simple explanations of
some of the interpolation modes. Trying all of the modes will give a better
understanding of what changes the image will incur. Remember, the higher-quality
reduction, the slower the process. The lower the quality, the faster the reduction.

Bicubic - D takes on a color value from a source matrix (S) based on a polynomial
function.

Bilinear - D takes on an average of colors from the nearest region of S (for example,
a 2x2 matrix)

High Quality Bicubic - D takes on a color value from a source matrix (S) based on a
polynomial function.

Higher quality Bicubic (will run slower)

High Quality Bilinear - D takes on an average of colors from the nearest region of S
(higher quality than simple Bilinear)

Nearest Neighbor - D simply takes on the color value of the nearest pixel in the source.

Cropping

Cropping the image will clip off the part of an image not specified in the new
dimensions of the image.

ADD STATIC OBJECTS

A number of static objects can be permanently added to the site. Inserting each type of
object is explained in the following passages.

Add an Access Point

Existing Access Points may be added to the floor plan to simply show their location.
First, decide whether you want to represent an 802.11a, 802.11b, or 802.11g access
point. Choose the icon from the toolbar with the correct letter on it (A,B,G). Now
click on the part of the floor plan where you would like to represent the access point.

Insert Text

1. Click on the text insertion button on the toolbox.

2. Click on the location where you wish to insert the text.
3. Enter the text.

4. Press OK.

Microwave/Directional Antenna/2.4 GHz Phone/Compass




Any of these objects may be placed on the floor plan. Simply click on the desired
object. Then click on the floor plan where you wish the object to be placed.

ADD CUSTOM IMAGES AS STATIC OBJECTS

Any custom bitmap may be added to the floor plan. Click on the “IMG” icon on the top
toolbar. Then choose an image file. Then click on the floor plan where you would like the

image.

ADD WALLS, WINDOWS, AND DOORS

Additional walls, doors, and windows can be added to the floor plan.

Walls

Click on the wall icon on the top toolbar. Then click where you would like the wall to
begin.

Then click on where you want the wall to end. A new wall has now been added to the
floor plan.

Doors

Click on the door on the top toolbar. Choose a single or double door using the
appropriate icon. Then click on where you would like the doorway to begin. Then
click on the other side of the new doorway.

NOTE: The doors will swing differently based on start and stop clicks. If the
finishing click on the doorway had been the starting click, the door would then swing
in the opposite direction.

Windows

Similar to the procedure for doors and walls, click on the window icon on the top
toolbar. Then click where you would like the window to begin. Then click on where
you want the window to end. A new window has now been added to the floor plan.

SAVE THE PROJECTION

1.
2.
3.

Choose FILE/SAVE from the menu.
Enter a name for your projection file.
You now have a projection file for use with the Collector.

STATUS BAR (Left)

On the left of the screen are different statistics. They are the pixels / foot (meter) ratio. You
can also adjust whether or not the measurement units are in feet or meters.

MENUS

There are 5 submenus located in the main menu at the top of the screen.



The FILE submenu lets you open or save site files.
NEW creates a new site file.
OPEN opens an existing site file.
SAVE saves a site file under the previously saved filename.
SAVE AS saves a site file under a new filename.
The EDIT submenu has editing options.
UNDO lets you undo up to 3 previous edits to the site.
The OPTIONS submenu contains system options.
SHOW GRID overlays a grid of lines on top of the site.
The SCALE submenu contains scaling options (see “Adjust the size of the floor
plan”)
Bicubic
Bilinear
High
High Quality Bicubic
High Quality Bilinear
Low
Nearest Neighbor
The HELP submenu contains help options.
ABOUT pulls up the about box.

RULERS

The rulers along the vertical and horizontal planes of the projection represent a scale of the
projection. These are set using the ruler toolbox option.

Z00M MODES

There are four different modes for zooming in and out of the floor plan.

Zoom In

Click on the magnifying glass with the ‘+’ sign. Then create a zoom rectangle by
clicking-and holding on an area of the floor plan. Then drag the mouse (while
holding down the mouse button) to the next point. A dashed rectangle will appear.
When the zoom rectangle is the appropriate size, release the mouse button. The floor
plan will now be zoomed into that rectangle.

Zoom Out
Clicking on the magnifying glass with the ¢-¢ sign will reduce the image resolution by
a factor of 2, thereby making the image zoom out.



Il. Coyote Collector

1.  INTRODUCTION:

The Coyote Collector is a part of the BVS Indoor Forecaster and is used to collect Radio
Frequency (RF) Data obtained during walk-studies of an in-building environment. An image file
linear coded using the BVS Projector is imported in the Coyote Collector and the data collected
is correlated to physical co-ordinates on the projected file. Data collected in this way is then
analyzed using the Analyzer.

This part of the Indoor Forecaster can run on any PC which can be mobile along with the
receiver for the purpose of point-to-point data collection in an in-building environment.

2.  DESCRIPTION OF TOOLBAR BUTTONS:

E) When this button is clicked, the user can load a projection file. IMPORTANT: It is important
to load the BVS Projection (file with extension BPF) file created using the BVS Projector before
opening a Coyote Collector File (File with extension CPF).

= Clicking this button lets the user either Create a new Coyote Collection File OR open a
previously created Coyote Collection File (File with extension CPF). This file is imported in the
Analyzer portion of the Indoor Forecaster for Coverage Analysis. The process of collecting data
for Coverage analysis is explained in detail later.

A Click this button to zoom into the current view.

= Click this button to fit the entire bitmap represented in the BVS Projection File within the
Client area of the view.

= Click this button to zoom out to view a larger area of the bitmap represented by the BVS
Projection File.

¥ Click this button to take a snapshot of the Client area of the window and save it as a Bitmap
(BMP) or a JPEG image file.

~ Click this button to show the Segment Data Dialog which displays information of the current
segment data being collected.



% Click this button to display the Coyote Receiver information once connection has been
established with the Coyote via the USB.

Coyoke Serial Mumber:- 270556

Receiver 1 Receiver 2
Installed 7 | Installed Installed
Minimurn Freq;- | 365.9300 MHz 1929,9900 MHz
Mazxirumn Freg:- | 893.9700 MHz 1995, 0000 MHz
Receiver Skep:- | 30,0000 KHz 30,0000 kHz

! Click this button to view, in pictorial format, the important instructions to be followed
before and during data collection.

3. STEP-BY-STEP PROCEDURE FOR DATA COLLECTION:

3.1  Establishing a Connection with the receiver:

Connect the appropriate connectors of the USB cable to the Samsung Q1 UMPC and the Coyote
Receivers respectively as shown:
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Before starting the software, verify that the USB cable is securely connected. Make sure
that the battery of the Tablet PC and the Coyote Receiver is well charged. Turn on the Coyote
Receiver by pressing the “Power” button on the front panel of the Receiver.

N

Once all the connections seem ok, double click the Coyote Indoor Forecaster Collector Icon on
the desktop. The following dialog will then pop up prompting a connection with the Coyote
Receiver.

Dewice Ta Canneck:-

BENEF0556 COYOTE BNS, Inc

|

Click “Connect” for the software to establish a connection with the receiver. Upon successful
connection, the Coyote Receiver characteristics will be displayed as shown:

12
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Coyote Serial Mumber;- 270556
Receiver 1 Receiver 2

Installed 7 | Installed Installed
Minimum Freq:- | 68,9500 MHz 1929,9900 MHz

Mazximumn Freq:- | 893.9700 MHz 1995, 0000 MHz

Receiver Step:- | 30,0000 KHz 30,0000 KHz

[ SELECT A PROJECTION ]

Ready Longitude = MA K= MA W= MA

- =[]

MM

3.2. Open the Coyote Projection File:

Once the connection with the Coyote receiver has been established, the Coyote Projection and

Collection Files would have to be loaded before the Data Collection can begin. Click to
open the Coyote Projection File (Files with extension BPF):

3.3 IMPORTANT NOTES ABOUT PROJECTION FILES:

(1). The Floor Plan in the Projection file MUST correspond to the area of Indoor Data
Collection.

(2). It is important that the Floor Plan reflect AS ACCURATELY AS POSSIBLE, the position
of furniture, doors, windows, walls, machines, plants, pillars, stairs, curves and turns in
structure. This will enable the user to accurately travel straight line distances and collect
accurate data.
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(3). It will be helpful to the user to study the Floor Plan and the actual area of walk study
and Plan the Data Collection Path beforehand to avoid any mistakes during the actual process.
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3.4 Opening the Collection Files:

Once the Projection File has been loaded, the software prompts the user to open/save the

Collection File (Files with extension CSD). This can be done by clicking  on the main Tool-
bar. Previously collected Collection files can be opened as well as new ones can be created:

Coyote Collector

\ ? ) Do wou wish bo open an existing data file?

Yes Mo
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;,EL- Untitled - Coyote Collector

File Edit Wiew Help

Bl & 2 H S BN T

A~
Loak in: I@ Coyote Collector Files j - I‘j( v
@ Coyvote Collector Test,csd
@ @ Coyote Collector Test_2,csd
My Recent ®
Documents @
Data 0.csd
@ Type: CSD File
- Date Modified: 6/28/2007 6:01 PM
Desktop Sizet 14.3 KB
(7]
My Documents
My CompLiter
-
Q File name: IData.c:sd j Open I
My Metwork Files of type: |Coyote Survey Data Files [*.cad) LI Cancel |
Pl
e [ Open as read-only
CRER=
pp—
ZERG
- [
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==
o
— — 0
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Once the collection and projection files have been loaded, dialog box containing VERY
IMPORTANT INSTRUCTIONS to be followed before data collection will pop up: Please carefully
read and understand these instructions before beginning any further data collection.
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IMPORTANT: Please read !

Projection and Collection Files have been I. Thiz Survey can be performed for a MAXTMUM
loaded 111 of two channels, one per receiver in the SINGLE

PLEASE FOLLOY THESE IMPORTANT STEPS: CHANNEL MODE ONLY.

OTHERWISE THE SURVEY DATA WILL NOT
BE COLLECTED PROPERLY AND THE 3. Using the keypad on the front panel of the
AMALYEER PART OF THIS SOFI'WARE Coyote unit, zelect the SINGLE CHAMNNEL
PACKACE WILL NOT BE ABLE TO ANALYZE  MODE and set the dezired frequencies.
THE COLLECTED DATA.

1. Select the number of channels for which you
~wizsh to perform the walk study. Only 1
Receiver iz needed in the Coyote if ondy 1
Channel iz 10 be surveyed and BOTH the
recenvers are needed to he plugged into the
Coyote if 2 channels are to be surveyed.

4, The FILTER EATE has to he zet to 1512 zec and
the SARPLING RATE has to he setto a
BIMIMUM of 64 zamples per second.

" 1 Channel {2nly 1 Receiver is needed),

" 2 Channels {Both Receivers are needed),

3.5 IMPORTANT INSTRUCTIONS TO BE FOLLOWED BEFORE
BEGINNING THE DATA COLLECTION:

Please follow these important steps otherwise the survey data will not be collected properly

and the analyzer part of this software package will not be able to analyze the collected data:

(1). Select the number of channels for which the walk study is to be performed. Only ONE
receiver needs to be installed in the Coyote if only 1 channel is to be surveyed. BOTH the
receivers need to be installed in the Coyote if TWO channels are to be surveyed.

(2). This Survey can be performed for a MAXIMUM of two channels, ONE per receiver in
the SINGLE CHANNEL MODE of the Coyote.

3). Using the keypad on the front panel of the Coyote, select the SINGLE CHANNEL
MODE and then set the desired frequencies.

(4). The FILTER RATE has to be set to 1/512 second and the SAMPLING RATE has to
be set to a MINIMUM of 64 samples per second.

Once the above instructions have been observed, select whether the walk study is intended for
a single channel or for two channels and then click OK. Carefully open the lid on which the

16



Tablet PC is mounted and using the keys on the front panel of the Coyote receiver, begin Single
Channel Measurement.

17



Close the lid once the measurements begin. The unit is now ready for indoor coverage
prediction data collection. Close the Receiver Cover and put the locks in place so that the Lid
does not accidentally open during the walk study.

3.6 IMPORTANT PRINCIPLES TO UNDERSTAND BEFORE BEGINNING THE DATA
COLLECTION:

(1). The software is designed to collect data segment-wise, meaning that the user has
to walk in a straight line between two points to form a data segment.

(2). On the floor plan loaded in the form of a linear coded projection file, the user
selects the start point and the stop point of the segment he wishes to traverse. The Start and the
stop points on the floor plan have to co-incide with the actual start and stop locations in the
building.

(3)- Once the start and stop points have been set, the user has to walk from the START
point to the STOP point in a STRAIGHT LINE and at CONSTANT SPEED. It is very important to
strictly observe this point for greater accuracy of data analysis.

3.7 STEPS TO FOLLOW FOR USEFUL DATA COLLECTION:

(1). Click “New Segment” button on the Segment Data Dialog, which pops
up after you close the Pre-Data Collection Instructions Dialog.

(2). Select Start Point on the Segment Data Dialog and tap the Start Point
on the projection file, corresponding to the actual position of the user on the Projection File.
(3)- Select Stop Point on the Segment Data Dialog and do the same as 2.

(4). Ensure that a straight line can be traversed between the Start and the

Stop points selected before clicking the “Start” button. If it is not possible to traverse a straight
line between the start and the stop points, change the stop point position on the projection to
enable a straight line traversal.

(5). Once it is ensured that a straight line between the Start and the Stop
Point is traversable, click the “BEGIN !!!” button. Walk the distance between the START and the
STOP Points in a STRAIGHT LINE and at a CONSTANT SPEED.

18



(6). Once the Stop Point is reached, click STOP. Data is no longer
collected in the Collection file after this. Repeat Steps 1 to 6 for all other segments. Data
collected in this way can be used in the Forecaster Analyzer for further analysis.

“i+ Untitled - Coyote Collector

File Edit %iew Help
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lll. Forecaster Analyzer

1. INTRODUCTION

Forecaster Analyzer is the analysis component of Forecaster software package for Coyote
receivers. It provides analysis of coverage, reliability, channel reuse and more.

2. GETTING STARED WITH FORECASTER ANALYZER
Table 1 gives the descriptions of the buttons in the Tool Bar to control the graph view.

Table 3.1. Buttons In The Tool Bar

Button Name Description

Y Zoom In Tool After clicking this hot button, the
cursor changes to a magnifying glass.

After clicking this hot button, the

= Zoom Out Tool
cursor changes to a zoom-out glass.
= Eit to Window Pressing '[hIS. hot key fits the image to
the current size of the graph window.
IE[ Fit to Map Show the graph image with the whole

map.

Show the GPS directions of the view.

& Show Directions (Disabled for indoor survey study)
L Show Map Show/Hide the map
b Information Window Show information as mouse hovers
= Legend Window Show legend for the graph
i Move Base Station Move base stations on the map
S Ruler Measure distance
Create a KML report
KML report (GPS data only: Disabled for indoor
survey study)
(]| HTML report Create a HTML report

Forecaster Analyzer uses a linear projected map from the Projector and data files recorded with
Coyote Collector.

The Projector generates a Projection File (*bpf) that contains the map of the survey.
The Coyote Collector produces a data file (*.csd) that contains the collected data.

2.1 Creating New Projects
The Forecaster is project based. To begin using the Forecaster, a projection file is first
generated (Please see the manual for the Projector). Click on the % hotkey located in the

toolbar near the top of the screen. The Projection File dialog box then appears. Open the
projection file (map) you wish to use.
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Then the data files must be loaded to create a project. The Forecaster Analyzer can process

multiple data files. To create a new project, select “New Project” from the File menu or the
Hotkey from the Toolbar.

E@, - Forecaster Analyzer

=N Wiew window  Help

Mew Projeck CErl+R
Cpen Exisking Project Chrl+D —
Save Project Chrl+5

Save Project As, ..

Print. .. Ckrl+P
Prink Preview
Prink Setup. ..

The data log file selection dialog then appears.

%]

Select the Survey Data File

Select the Data Files that wou wish to
base this project on

add | Show Selected File | [

|

L)

| | Zancel |

In the data log file selection dialog press the “Select” button and browse for the *.csd files you
wish to work with.

More files can be selected by clicking on the “Add” button. If you wish to use two or more files
that you have collected, the data in these files can be merged to process by checking the box
before “Merge Data”. If a file is added in by mistake, check the box before the file and then
press the “Delete” button. All selected files will be deleted. Click the “OK” button to load the
data in the files.
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Select the Survey Data File

base this project on

%)

fdd

=1- [ 5elected Files

Lo
Select the Data Files that wau wish o e 'f
1 o
-
k-
|'::'I,"."iSLIa|5tLIIjiI:I'I,CI:I‘;.-'I:ItEE':.-'E'I,E}CamD|ES'I,C5DFi|ES'I,CD' _1 b Sl
1
e e~
W Merge Data Lo ”l
FooT
Pt

Ik Delete

b

Zancel |

C:'I,'l.l'isua|5tudiD'I,CD';.-'DtE:E';.-'E:'I,Examp|es'I,CSDFHE:S'I,CD';.-'DIZE: Collector Tesk_1 .n:sd|
CiiMisualStudiot CovobeEve \Examples\Cs H o

Note that the “Merge File'" means merging the data in the files in the process. It does not

mean that multiple files are merged into one file.

2.2 Saving A Forecaster Project

At anytime after a project has been created it can be saved to a file. The current setlings
including state of controls and graph (map, bitmap and analysis) are saved in a project file and

can be recalled later. To save a project select Save or Save as... from the File menu or the b

hotkey from the Toolbar.

:‘_3, Untitled - Forecaster Analyzer

=W Wiew Window  Help

Mew Project
Open Existing Project

Save Project

Save Praject As. .,

Prink. ..
Prinkt Presview
Print Setup...

Chrl+M
Chrl+0

Chrl4-P

If the project has previously been saved the Save option will overwrite the existing file while
the Save as... will allow a new file name to be selected.
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2.3 Opening An Existing Forecaster Project
To open an existing Forecaster Project, select Open Existing Project from the File menu or the

= Hotkey from the Toolbar. A dialog box will appear to allow the selection of the project file
(*.fws).
The Forecaster Analyzer screen is displayed in two sections:

The left pane of the display The right pane contains
contains the Control Window used the graph and the map
for Clustering Points, View from the Projector.
Options, Channel Selection, and

Reliability Analysis.

«. - Forecaster Analyzer,

File Wigw Window Help

BRecn sHE NENEEN=]
14337 ]I

Clustering Points

= Survey Channels
[#] % 950.0000 MHz, | CH: 1
[ 950.0000 MHz, | CH: 1

R E—
Trans. Power (dBm); |:|
Antenna Gain: [ ]
Antenna Height (F- [ ]
Antenna Direction (Deg.): |:|
Antenna Position {in Feet)

N —

I —

== > v
A EPA

(gt Je [Wergels J

% Ry 11084 77 Tapes 171.27 201
Ready (1 = 66,318, ¥ = 132.694)
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3.  Survey Data Analysis

3.1 Clustering Points

After loading the data files, the interface for clustering points is shown. This is used to separate
the data with same frequency, but they are received from different base stations (BS). The
automatic clustering has been done when this interface is shown. To further separate the points

manually, click the “* Hotkey, left click and hold on the graph to start the clustering. As the
mouse is up, the points within the rectangular will be grouped. To merge two groups (channels)

with the same frequency, check the boxes before them and then click Button [FIEIZE]Y

When a channel is selected (the box is checked), the parameters for the BS antenna are shown.

Please type in the parameters if they are known. Press the button to input the
information.

:‘_3, - Forecaster Analyzer
File Wiew Window Help

B s eodE EEHE

Clustering Points

= Survey Channels
[#] ¥ 9s50.0000 MHz, , CH: 1
[#] ¥ 960.0000 MHz, , CH:

Mame: | / |

Trans. Power (dBm):

[ ]
Antenna Gain: |:|
[ ]

Antenna Height {Ft):

[Input | [Merge |4 J

After base station antenna's position is input, the BS marker will be shown on the graph. To

move the BS marker, click =, left click at the center of the BS icon, hold on the graph and
move it to the correct location. Table 3.2 gives the descriptions of the buttons to cluster points.
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Table 3.2. Buttons In Gontrol Window For Clustering Points

Button Name Description
== GPS Status Show GPS status by black circles. 3D fix: No black circles;
a 2D fix: small black circles; No fix: big black circles.
(GPS only: disabled for indoor study)
- Show/Hide Show or Hide base stations on the map
B3 Base Stations
Y/ﬁ Y/X or Lat/Lon Y/X: Use linear distance (feet or meter) in the axis
B Lat/Lon: Use Lat/Lon (decimal degree) in the axis
(Only Y/X coordinates for indoor study)
Vertical Grid Show vertical grid lines
= Lines
Horizontal Show horizontal grid lines
Grid Lines
[Thput ] Input Input the parameters for base stations and antennas
Parameters
[Merge]s | Merge Groups | Merge multiple groups with the same frequency into one.
Finish Process the data after clustering is done
Clustering

Atfter the clustering is finished, click the """ hutton to proceed to the next step of post

processing.
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3.2 Measurement Data Analysis

Table 3 shows the descriptions of the buttons used in the control window to analyze the
data.

Table 3.3. Button In View Options Of Control Window

Buttons Name Description
B, Walk/Drive Show/Hide Walk/Drive Path
- .-!-
= Path
= Path Width Change the Width of Walk/Drive Path
GPS Status Show GPS status by black circles. 3D fix: No black circles;
X 2D fix: small black circles; No fix: big black circles.

(GPS only: disabled for indoor study)

[ Show/Hide Show/Hide Base Stations on the Map
B3 Base Stations
HILT_L Coordinates Y/X: Use the linear distance in the axis
/§ Lon Selection Lat/Lon: Use Lat/Lon (decimal degree) in the axis

(Only Y/X coordinates for indoor study)

Horizontal Grid | Show/Hide grid lines in X direction
Lines
Vertical Grid Show/Hide grid lines in Y direction
Lines

L i Lines| | Number of Grid | Change the number of lines in the grid
Lines

Plot RSSI Along | Plot the measured RSSI along the survey path.
Path

ak
ak
—_—

Plot Averaged Plot the averaged RSSI along the survey path.

L ol

Path

R RSSI Along
I

Plot The Plot the number of RSSI for 40-lambda averaging along the
| Averaging survey path.

Number Along
Path

Phi Plot Reliability | Plot the reliability of averaged RSSI along survey path
s Along Path

+dBy Plot Variation Plot the Variation of Averaged RSSI Along Survey Path
s Along Path
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3.2.1 Plot RSSI Along Survey Path

0,
To plot the raw RSSI along the survey path, click on the : button and then select the
channel. A colorful drive path is shown below. The range in the map is from -30 to -120

dBm. To change the range of RSSI, please move the stiders above.

- orecaster Analyze ]
File Wiew ‘Window Help

Brxec S FHSE H

“iew Options (3) Fath
—— test?_nogps(revd)
: f 1 ) —l_'[ ., - e | Piower dBrm
Channel Selection &MJ - ro i
Select Power Range Brm . oy 4839
-12 =z L5748
_qv-'*l — i 657
s T Nil f'bil thi|/ , 7556
B e 2 . 5475
[J# 2512.0000 M, , CH: A~ ,-93:-84
O 252208 MHz, , CH: . 10293
2920000 MHz, , CH: .oz
2547,0000 MHz, , CH: ;| M. 120111

[J# =s52.0000 MHz, , CH:
[J# =572.0000 MHz, , CH:

< | =

||

B3.86

¥ Rssi NAME

CH  FREQMHz)

BS Location of Selected Channel
(| NiA | ety [ |
Fath Loss Exponent: Mlidy

Shadowing Std. in dB: b9.20

gl 45 dBm 2447 2047.0000

:2:7] 1 selected channel covers this paint

El 6.6 Feet(T)| |B] 6.6 Feeti¥)

i b it ; » BERKELEY
I | o 0" %o ..:.‘i:-unmmnmns
i v % 52.18 93.44 13¢ Clarifying RFO8® SYSTEMS.
Ready %= 121,537, ¥ = 29,659)

3.2.2 Plot the Averaged RSSI Along Survey Path

S
To plot the averaged RSSI along the survey path, click on the ;l button and then select
the channel. A colorful drive path is shown. If none of the channels is selected, a dialog will
pop up to ask for selecting channels. The range of RSSI can also be changed by moving the
sliders above.

3.2.3. Plot the Number of Points For Averaging Along Survey Path
The number of the points, which are used for averaging, can also he plotted along the

Ny
walk/drive path. Click on the 4| button under “Channel Selection and Analysis”. A dialog will
be popped up to take the range for the numbers.
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3.2.4 Plot the Reliability of Averaged RSSI Along Survey Path

Phb i
To plot the reliability of averaged RSSI along the walk/drive path, click on the button J
under "Channel Selection and Analysis". A dialog will be popped up to take the range for the
reliability. The default value of RSSI variation to calculate the reliability is 1dB. For example,
if the reliability is 90%, it means that the possibility that the averaged RSSI is within = 1dB of
the real mean value is 90%. The accuracy of the averaged RSSI to the real mean value
increases with the reliability. Assuming the number of points |s N, the reliability is p, the
standard variation is o, the equation to calculate the reliability is'

This figure showing the reliability of averaged data is show below.

. - Forecaster Analyzer |Z||E|g|
File “Wiew window Help

B%e0D FEHS HE& SEAQAEHE OO %

Wiew Options (3) | [67.82 Path
—e— test?_nogps(revd)
Channel Selection & Analysis (£ Prob [%]
Select Power Range in dBm [ gg;gﬂ
1200 T - 30 7080
e e — 6070
0, §i| Nil[ 22+ tdBTl 50:60
R R L . 2050
[J% 2512.0000 MHz, , CH: . 30:40
CJ% z5zz.0000 MHz, , CH: . 20:20
% 25320000 MHz, , CH: . 1020
[#13# 2547.0000 MHz, , CH: . 010

] =2552.0000 MHz, , CH:
[J# =2572.0000 MHz, , CH:

v
< | >
- - 5386
BS Location of Selected Channel
{1ty | A B |
Path Loss Exponent; T2
Shadowing Std. in dB: T2 et
3] Rl
b I‘eet[‘f% h.b I‘eet[}{% q Qoe BERKELEY
]| e . 0. .n.-.ﬂlnnlln[llllus
T, . % SYSTEMS
e —— b »ff{ 52.18 93,44 134 Clarify ) RFS ®
Ready (% =138.090, ¥ = 150.853)

: Please refer to the book — “The Mobile Radio Propagation Channel”, David Parsons, John Wiley & Sons,

New York, 1992.
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3.2.5 Plot the Variation of Averaged RSSI Along Survey Path

+dB]
To plot the averaged RSSI along the walk/drive path, click on the button _| under "Ghannel
Selection and Analysis". A dialog will be popped up to take the range for the variation. The
default value of the reliability to calculate the reliability is 90%. The accuracy of the
averaged RSSI to the real one decreases with an increasing standard variation. Assuming the
number of points is N, the reliability is p, the standard variation is o, the equation to calculate
ois

_5.57erf ™ (p)
o(p) = v

3.3 Coverage Analysis and Prediction
3.3.1 Plot Contours
The detailed coverage analysis and prediction with contours can be shown by pressing the

Flat Contour = putton. A dialog will be shown to ask for the minimum and maximum values

for contours.

Set Up Plot Range §|

Please input the maximum and minimu
wvalues Far plokting:

Mairumm value (dBm); I:I
Minimurn walue (dEm): I:I

Either the signal strength or the number of channels (V) in the coverage area can be shown
by clicking the g (signal strength) or the I j (number of channels) button.

3.3.2 Draw Controls

The range of the power (or number of channels) is shown in the following range control
diagram. Move the sliders on the range control by clicking and holding the sliders to the
desired value and the contours for the two values will be displayed in the graph window.

Dirany Signal Powwer Contour (dBrm)

rBlll..l.i.l..l..j’l..l.|_£
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3.4 Reliability Analysis

Reliability Analysis shows the radius, boundary reliability, cell reliability and power
threshold of the channel(s). The user can input numbers via the keyboard and calculate the
coverage reliability in the control panel.

Channel(s) selected for Reliability Analysis is done with the channel selection list. After
selecting the channel(s) use the buttons in the control pane to calculate reliability analysis.
To do single channel analysis select '"Single Analysis'" and the last selected channel is
analyzed. Click on the “Reliability Analysis” button and input Power Threshold and

Radius. Click : 1 and the boundary reliability for this channel is shown under "Bn.
Reliability'" and the cell reliability is also calculated and shown. The coverage of the last
selected channel with the radius is shown as a circle on the graph window. The reliability
represents the probability that the received signal's strength is larger than the threshold
value. The boundary reliability stands for the probability of the signal received at the
boundary of the cell to be greater than the threshold, the cell reliability stands for the
probability of the signal received within the cell to be greater than the threshold. On the
other hand if power threshold and probability (boundary reliability) are known click
% | and the radius and cell reliability will be shown. If "Group Analysis" is selected
then all the selected channels will be analyzed with the same input data. An example is
shown below where the transmission power is 1W and the antenna height is 2 meter.

Note: If the “Reliability Analysis” is open then the software is set to this mode. To see the
coverage of the selected channel(s) click the “Reliability Analysis” again to pull up the
interface and close this mode.
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“¥, - Forecaster Analyzer

File Wiew wWindow Help

B%e0f sHE ¢ WOsRAGEH =0 ?|

|

BE Location of Selected Channel

it 33.63

Enter Power

ing Std. in dB:
Threshold _
f Feet(¥)| Bl 6.5 Feet(X)
| | |

| wim: (12721
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Enter one of
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Then

click on _|
one of
these
arrows to
calculate

b

0
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4. SOME FUCNTIONS IN THE ANALYZER
4.1 Metric Selection
Measurement information can be displayed in feet or meter. The default setting is feet. To

select the metric use the “* Hotkey located on the top toolbar. Left click on the hotkey and the
metric selection dialog box appears.

Metric Selection @

Please select the metric:

1 Feet _:_J

4.2 Information Window
The following figure shows the analysis of measurement data by using the information

window. Click on the | H hotkey and then move the mouse to the point to be analyzed. Stay
at the point for a second and the information window will be shown. The information
window in this figure shows that the averaged value at this point is —80 dB, which is
averaged by 48 samples. The real mean value has 79% possibility within -80+1 dB.

:@, - Forecaster Analyzer |Z||E|E|

File  Wiew ‘window Help
il = EHE HE SRS EE B ®
2 —— — ~ Path
_:T :S_Tl ':ﬂ':i ?'E‘T i;]-?T 0 —— test?_nogps(revd)
[ 2512.0000 MHe, , CH: A | Prob (%]
[J3% 2522.0000 MHz, , CH: . 50100
[]3 2532.0000 MHz, , CH: 8040
[F] % 2547.0000 MHz, , CH: ,gg:gg
1% z552.0000 MHz, , CH: E0ED
% 2572.0000 MHz, , CH: | . 4050
< | & . =040
B ;] . 20:30
BS Location of Selected Channel 795 -2 c = 1DE.I:1200
Vit [33.63 | it [T27.21 | T
Path Loss Exponent: 4 -
Shadowing Std. in dB: S\ FRECIMHZ) - NAME .
B30 cd2 dBm 2447 25470000 o
Bl 5.5 Feet(T)| B 6.6 Feet(X)
il | ] 1 zelected channel covers this point
oo ) =
Plot Contour k‘\‘
9 4K
Reliability Analysis ] ™ BERKELEY
0y %05 pa 8 e uaRITRONICS
v | % GElE, EEFT T5% Clarifying r9a®  OYSTEMS,
Ready (¥ = 137,564, ¥ = 42.715)
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4.3 Channel Selection

Select the channels or group of channels you wish to work with in the control window under

“Channel Selection”. The Channel Selection tool contains a list of all channel(s) that are present
in the log files. Checking the box next to the frequency includes the channel(s) in the analysis.

As the channel is selected, its coverage graph will be shown in the graph window.

4.4 Color Selection
The color indicator between the frequency and the check box has two functions:

One is to select the color used to graph signal strength from that channel(s). To change
the color for a selected channel(s) right click on the color indicator. A color selection
dialog box will appear.

The other is to select how channels are grouped for analysis. After checking the
channel, the RF coverage of that channel will be shown if it is not in the Reliability
Analysis mode. If it is in the Reliability mode the area with certain reliability is shown.
Reliability Analysis is explained in the next section. There are two conditions the user
can choose from as shown in the following table:

Example Grouping Description

Example Grouping Description
= Survey Channels Individual Each selected channel is graphed in
[ % 900.000 MHz, CH: 1 its own color indicated by the color
[J# 570.000 MHz , CH: 35 of the star.
SR mE 3oy Channels Group Selection | The best coverage for all channels
O 500,000 MHz, CH: 1 is shown using the group color.
870,000 MHz , CH: 35

4.5 Range Control
This feature allows users to control how the signal strength is represented using a graph.
The two sliders set the minimum and maximum values for the graphing range.

Use these sliders to control minimum
and maximum settings.

Select Fower Rande in dB

Use these sliders to

Use the “R” button to AN change the values

set the default resolution
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The resolution control shows the size of the points calculated. Setting the control for low
resolution will reduce the calculation time and decrease the resolution. The button = resets the
control to a reasonable default setting.

4.7 Measuring Distances
Distance measurements can be made on a graph by using the ruler tool. To measure

distances use the % hotkey. Left click and hold on the graph to start the measurement. By
releasing the button the distance is displayed by a distance dialog box.

Ruler [‘5—<|

[ Fipiik | K. |
First
Boirt by 114.295 X |?E.4EEI Cancel

Second vy 79.278 = |1 18.5824
Fairt
Calculation

Cutput

Digtance [Feet) 3422

4.8 Saving Coverage Graph
The current coverage graph can be saved as a bitmap. Select Save Graph Image... from the File
menu.

E@, - Forecaster Analyzer
=0 View Window  Help

Mew Project CErl+R i
Open Existing Project Chrl D T
Save Project Chrl+5

Save Project As...

Save Graph Image. ..

Print. .. Zhrl+P
Prink Presiew
Prinkt Setup...

4.9 Change Base Station Icons
Right click on the base station, a dialog to select base station image is shown. Click on the
desired image, press “OK” Button.
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BS Image Selection |E|

—Please Select:

A

At

Selected:

ey

Ok I Zancel |

4.10 Printing
The standard Windows printing selections Print, Print Preview and Print Setup are available
from the File menu.

%, - Forecaster Analyzer

=M view  Window  Help

Mew Project i+l § [
Cpen Existing Project Chrl+0 e
Save Projeck Chrl+5

Save Projeck As, ..

Save Graph Image. ..
Save Table as...

11t

Prinkt Preview
Print Setup. ..

4.11 Table View
To view the data point in tabular form select Table Window from the Window menu.

5 Untitled - Forecast

File  ‘Wigw

B %

An example of a table view follows on the next page.
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. (Table View)

Fille Wiew ‘Window Help
S =HEHE 7
# Freq[MHz] X[ Y[f] Sr Sa N Time Date S
0 26250000 2142 1099 -7 -5¥ 23 08:03:57 1242812007
1 26250000 2140 1099 -7 08:03:57 121282007
2 26250000 2138 10949 -7 08:03:57 121282007
3 26250000 2137 10949 -7 08:03:57 121282007
4 26250000 2135 10949 -7 08:03:57 121282007
5 26250000 2133 10949 -7 08:03:57 121282007
[ 26250000 2132 10949 -7 08:03:57 121282007
7 26250000 2130 10949 -7 08:03:57 121282007
8 26250000 2129 10949 -7 08:03:57 121282007
9 26250000 2127 10949 -7 08:03:57 121282007
10 26250000 2125 10949 -7 08:03:57 121282007
11 26250000 2124 10949 -7 08:03:57 121282007
12 26250000 2122 10949 -7 08:03:57 121282007
13 26250000 2120 10949 -7 08:03:57 121282007
14 26250000 2119 10949 -7 08:03:57 121282007
15 26250000 211.7 10949 -7 08:03:57 121282007
16 2625.0000 2115 109.9 -bi 08:03:57 12}2812007
17 2625.0000 211.4 109.9 -bi 08:03:58 12/2812007
18 2625.0000 211.2 1099 -bi 08:03:58 12/2812007
19 2625.0000 211.0 109.9 -bi 08:03:58 12/2812007
20 2625.0000 210.9 109.9 -bi 08:03:58 1272812007
21 2625.0000 210.7 109.9 -bi 08:03:58 1272812007
22 2625.0000 210.6 109.9 -bi 08:03:58 1272812007
23 2625.0000 210.4 109.9 -bi -60 23 08:03:58 1272812007
24 2625.0000 210.2 109.9 -bi 08:03:58 1272812007 w
Ready 1 Channels
where

Freq: Frequency.

X(ft): The coordinates of the point along X in the map in feet.
Y(ft): The coordinates of the point along Y in the map in feet.
Sr:  First stage filtered data.

Sa: 10 lambda averaged data.

N: The number of points for 10-lambda averaging.

Time: Record time.

Date: Survey date.

To save the table in a form that can be used by spreadsheet applications and other programs,
select Save Table as... from the File menu. The output is 40-lambhda averaged data. Please
check Appendix A for the data processing algorithms.
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¥, [Table View)
Wiew Window  Help

Mew Project Chrl+h i
Open Existing Project Chrl+0
Save Project Chrl+5

Save Project As..,

Save Graph Image. ..

Save Table &s...

Prink. .. Chrl+P
Prink Presview

Prink Setup...

The save table options dialog then appears.
Save Table Options

File Save Options

¥ Include Column Headings
Cancel |
¥ Enclose Skrings in Quokes
Delimiter:
& Tah
™ Comma

" Space

" Other: I

The output is an ASCII file that can be customized for easier conversion to a specific program.
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5. CREATING REPORTS
5.1 HTML Report

HyperText Markup Language (HTML) files can be opened by Internet Explorer and can
contain formatted text and graphics. Forecaster Analyzer can create a HTML report that
has the information about the data survey files, the selected channels, the coverage of signal
power and the number of channels per location.

To use this feature select E Hotkey. Select a file name to store the file when the dialog
box appears. A dialog box for HTML report options will be shown. If no “Plot Contour” is
implemented, the button “Show Coverage” and “Show BS Overlap” will be disabled.

HTML Report Options [‘5_<|

Show Selected Files

Show BS's Infarmation
Shiowe WwalkDrive Path

Show Coverage

Show BS Overlap

[ (9] 4 l [ Cancel ]

If “Show Selected Files” is checked a message box will appear asking if the selected files are to
be displayed in the report. If “No” is clicked, all the files will be displayed in the report.

. | ,) Show Selected Files Only?

Yes Mo

Then a dialog appears to take the notes for the selected file. Enter the notes for the different
files by clicking the “Prev” or “Next” buttons. After entering the notes for all the files then
click “OK”. All notes will be stored and displayed in the report.
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Input File Notes E'

Please input the notes For this file:
File Marme: COYOTE
Created: 12/6/2005, 19:40:20

1 auk of 2 files

Makes:

K | Presw | Mext |Cann:e||

If “Show BS’s Information” is checked in the dialog for HTML report options, a message box will
appear asking if only selected base stations are shown in the report. If “No” is selected then all
of the base stations will be displayed in the report.

Show BSs

1 ) Show Selected Base Station Only?

Yes Mo

Then a dialog box appears to take the parameters and notes for the selected base stations or
channels. The parameters input at the interface for clustering points are shown here.
Modify the parameters and notes for individual BSs by clicking the “Prev” or “Next”
buttons. After entering the notes for all BSs click “OK”. All notes will be stored and
displayed in the report.

39



Antenna Information and Notes

Please input the infarmation Far this channel:
1 out of 1 BSs

Freq: 70,000 MHz

Marne:

Transmit Power (dEm) :

Antenna Gain:

Ankenna Height(FE)

111

Direction (Deqg):

MNotes:

Ik I Presw | Mext | Cancell
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Appendix I: Indoor Site Survey Study
I. Rayleigh Fading and Terrain Based Fading

There are two types of fading that are relevant to performing coverage
measurements, fast fading, also know as Rayleigh fading, and terrain based fading due to
obstructions and propagation loss. The goal of coverage measurement is to measure the
local signal strength in presence of terrain based fading.

Rayleigh fading is due to close in reflections. It produces drops in signal strength
that are only a fraction of a wavelength in size (often on the scale of inches). These
fades always exist and are only of interest in the sense that coverage measurements
must be made in a manner that rejects Rayleigh fading, so that accurate
measurements of terrain-based fading can be made.

Il. Reject Rayleigh Fading

It is important to realize that Rayleigh fading is a spatial phenomenon not a time
one. The averaging is intended to be done over a certain distance, which can be optimal in
rejecting Rayleigh fading and keeping terrain information. In an outdoor environment, the
location information during a drive study can be achieved through GPS, which updates
every second. Therefore, sufficient measurements can be collected quickly and easily for
outdoor measurement.

There is no positioning system for most indoor environments, such as hospital,
shopping malls, office building, and so on. It increases the difficulty to collect sufficient data
to reject the Rayleigh fading. There are three collection methods [1],

1) Manual collection. In this method, one measurement of the signal power with its
location is recorded. However, the signal power can vary from a few dB to 20 dB
in several inches due to Rayleigh fading. Therefore, this method provides the
inaccurate measurement data since it cannot effectively reject Rayleigh fading.
Furthermore, it needs a large amount of measurement not to distort terrain
based fading.

2) Spinning antenna method. At a fixed measurement location, the antenna moves
along a circle orbit and the collected data is averaged and saved. This method
can remove the Rayleigh fading in the measurement. However, similar to the
first method, it also needs a large amount of data to keep terrain based fading.
Furthermore, the possibility of averaging correlated data reduces the accuracy of
the measurement.

3) Linear averaging method. In this method a test engineer walks along a straight
line and the measurement tool records the signal strength during the walk. In
post processing, the software will select the independent points and then average
them to get the local mean power. This is the most efficient method and it
provides the most accurate measurement. For example, people can walk 100 feet
in 1 minute. Assuming the carrier frequency is 2.5GHz. So the wavelength will be
0.4 feet. If the first or second method is used, the test engineer needs to measure
250 times for each wavelength or 25 times every 10 wavelength. It obviously
takes much more time than the linear averaging method.
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This linear averaging method is used in Indoor Forecaster software and the data is collected
in this way,
a. The test engineer taps the start point and end point on the map,
b. The test engineer presses the button to start the measurement and then
walk straight with a constant speed toward the end point,
¢. The test engineer presses the button to end the collection when he arrives
at the end point.

Ill. Data Processing Algorithms
The position of each sample is interpolated from the start and stop point. This is
done assuming a constant velocity during the walk. The interpolation equation is

P-P )
F. = % + F,, Where F, and P are the start and stop positions and i = 0,1...N (1)

There will be two stages in processing the data, which are shown in Figure A1. The first
stage is to filter out the correlated/redundant data. To eliminate the bias in estimating the local
mean power, the spatially independent data have to be used for averaging. The spacing used in
the software is 0.38), which is the minimum independent distance for Rayleigh fading. The
filtered data will be shown in the Forecaster Analyzer as the “raw data”. The second stage is to
average the data. Due to the complexity of indoor environments, a window length 10X is used
in averaging to remove Rayleigh fading and to keep terrain based fading. Therefore, there will
be about 102./0.38)\ = 26 independent samples for averaging. The averaging with 26 samples
indicates that the measured local mean power has 90% possibility to be within =1.8 dB of the
real value [2]. Table A1 shows the reliability of averaging 26 independent samples. Figure A2
shows the table report of the data, where N represents the number of samples used for
averaging within 10 lambda.

__________________________________________________________________________________

Figure A1: 10 Lamhda averaging process

Table Al. Measurement reliability with respect to the number of independent samples

N Reliability (%) +0 dB
26 99 2.8
26 90 1.8
26 64 1
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Figure A3 demonstrates the first-stage filtering procedure. For 0.38A independent
spacing, sample at P , will be selected and the one at Py ; will be deleted. The next selected
one will be at Py 4. Thus there will be totally 26 samples selected for averaging (P, ;, i =0, 2,
... 50) and 25 samples will be filtered out (P, ;i =1, 3, ... 49) in 10 Lambda from P, to P;.
However, if the spacing between each adjacent samples is 0.25A, there will be totally 21
samples (P, ;, i =0, 2, ... 40) selected for averaging.
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Figure A2. Table report of indoor site survey data.
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Figure A3. First stage filtering demonstration.

III. Indoor Forecaster Site Survey Software

Indoor Forecaster software will provide the analysis for averaged data, coverage
validation, prediction, and reliability. Indoor Forecaster software provides two stages of
analysis. The first stage is the analysis of averaged data. The software will filter out the
redundant data and average the samples using 10N window to keep the terrain based
fading. The software can show the signal strength of independent data and averaged data
on the map. The software can also shows the reliability analysis based on the number of
independent samples for averaging. The reliability of the averaged data is related to the
number of samples for averaging [2]. Secondly, the Forecaster software can provide the
analysis for coverage validation, prediction, and reliability. Based on the measured signal
strength and locations, the cell radius with a certain outage probability or the cell reliability
with a certain radius can be estimated through a robust method [3]. Figure A4 shows the
averaged signal strength along walk path. The place with yellow color has signal strength
from —48 dBm to -39 dBm. It indicates that the high data rate can be achieved at this

43



location. Fig. AS shows the RF coverage for survey area, where the signal range is from —75
dBm to —-30 dBm.
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